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Objectives: 

• Understand the use of spreadsheets and Excel 

• Learn the parts of the Excel window 

• Scroll through a worksheet and navigate between 

worksheets 

• Create and save a workbook file 

• Enter text, numbers, and dates into a worksheet 

• Insert, and remove columns and rows 

• Insert formulas and functions 

• Insert, delete, move, and rename worksheets 

• Preview and print a workbook 
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Introduction to Microsoft Excel 2007 

Microsoft Excel is a very powerful tool for you with too many features used to 

enter and analyze data. A Microsoft Office Excel is a spreadsheet looks a lot 

like a table you might see in a word processing package, but it has some very 

important features. In Excel each document is referred to as a workbook. 

Within each workbook you can have multiple spreadsheets. 

 

 What do I see first? 

When you start up Excel, the first thing that you see is this: 

 

 

 

This is a workbook. A workbook is a collection of worksheets (spreadsheets) 

and macros. By default, Excel creates 3 worksheets in a new workbook. The 

worksheets are designated at the bottom part of the window where you see 

the file folder-like tabs. The tabs are named Sheet1, Sheet2, and Sheet3. If 

you click on Sheet2, you will be in Sheet2 and not Sheet1, so you need to be 

aware of which worksheet you are in. 
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Exploring Excel 2007 

 

Figure 1 The Excel window 

In figure 1, immediately below the Ribbon is the Function Bar (or formula 

bar). The left portion of the function bar shows you what cells are currently ac-

tive. In Figure 1e the active cell is A1. The right part of the bar displays the 

contents of the cell, and more importantly, if a function has been entered the 

function is displayed. The cell within the spreadsheet normally shows the re-

sult of the function.  
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Figure 2 The Function Bar 

 

In Figure 2 the cell A1 shows 16, while the function window shows the formula 

(=4*4). 

The Function Bar, Cell A1 contains the function 4*4. The result of the function 

is displayed on the sheet (16) and the function itself is shown in the function 

window (=4*4). 

 
Exercise 1: renaming a worksheet 
 
I suspect that you will want to rename the worksheet(s) to something more 

relevant to your needs. To rename a worksheet: 

1. Double click on the sheet’s tab (notice the name becomes highlighted) 

2. Type in the new name 

3. Hit enter to complete the rename process 

Office Fluent user interface 

In Excel 2007, the new help users to find the right features more efficiently. 

The interface contains three main components; The Office Button, The Quick 

Access Toolbar, and The Ribbon. 
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Title bar is a bar that displays the name of the active workbook and the Excel 

program name. 

Ribbon is the main set of commands organized by task into tabs and groups. 

Workbook window is a window that displays an Excel workbook. 

Sheet tabs, the tabs that displays the names of the worksheets in the 

workbook. 

Formula Bar is a bar that displays the value of formula entered in the active 

cell. 

Office Button is a button that provides access to the workbook-level features. 

 

Open a New Workbook 

Sometimes you have to create a new workbook. 

1. Click on the Office Button                                   

2. Click on New                                                                         

 

You are now able to open recently used or new workbooks from this panel. If 

you click on Blank Workbook, Excel will create a new workbook for you. 
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(You could also open a new workbook by hitting CTRL-N, or by adding New to 

the Quick Access Toolbar. Both of these methods open a blank workbook 

without going through the New Workbook wizard.) 

 

What are Columns, Rows, and Cells? 

 Columns are the vertical markers in the worksheet and are denoted by the 

alphabet i.e. A, B, C.  

 The rows are the horizontal markers in the worksheet and are denoted by 

numbers i.e. 1, 2, 3.  

 Cells are the single box that you get where the column and row intersect 

i.e. A1, B3, and C2. 

You will often need to know the cell reference. The cell reference is the cell’s 

name and you can find that by looking at the toolbar. This means that the cell 

that is selected is named A1. 

 

 

Entering Text, Numbers, and Dates in Cells 

 The formula bar displays the content of the active cell 

 Text data is a combination of letters, numbers, and some symbols 

 Number data is any numerical value that can be used in a mathematical 

calculation 

 Date and time data are commonly refer for date and time values 
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Selecting a cell: 

1. We are going to select C28. Look for the C column. 

2. Look for the Row number 28. 

3. Once you have located it, click on it. 

4. Look at the toolbar; the cell reference box should say C28. If it does not, try 

again. 

5. After you have done this, click on a different cell and note the cell reference 

box. 

Selecting a group of cells A4 to D10: 

1. Click on the first cell A4 

2. Click and Hold the mouse button down. Drag the cursor down to D10. 

3. Let go of the mouse button. 

4. If you did it correctly, you should see a Highlighted box around those cells. 

If not, try again. Please see the picture below. 

 

 

Basic data entry, fill handle: 

From the example above, we have numeric (year, numbers) and text (months) 

entered as data in our worksheet. Let us practice by re-creating the example 

on our own. 

Method 1: 
1. Click on cell A2 to select it. 

2. Type in 1981 and hit Enter. Notice by hitting Enter, we automatically move 

down to the next row.  

3. Click on cell B1 to select it. 
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4. Type in January and hit Tab. By hitting Tab (or right arrow), we move to the 

next column. 

We can continue to doing this to enter the data from 1981 to 1992 and so on, 

but Excel provides us with a tool to complete sequences. 

 

Method 2: 
1. Click on cell A2 to select it. 

2. Type in 1981 and hit Enter. 

3. Type in 1982, and then select both cells A2 and A3. 

4. Move your mouse cursor over the fill handle (small black box on the bottom 

right of the active cell) so that the cursor turns into a cross. 

5. Click and drag the fill handle down to the cell desired 

. 

An Auto Fill Cells 

If you wish to enter a series of numbers you can speed up the process by us-

ing the auto fill capability. To use auto fill, enter the first two numbers in the 

series in adjoining cells. Select both cells, grab the common handle (the little 

black box in the bottom right hand corner of the selected cells – see Figure 

below) and drag down as far as needed. You should now have a series of 

numbers, following the pattern of the first two you entered. This trick will work 

for letters and formulas as well as numbers, and works for columns and rows. 

As shown in figures below. 

 



  
Assis. Lect. Abeer Abd Alhameed Alsallami) 9 

 

More commands are used only when you need them 

 

z  

Instead of showing every command all the time, Excel 2007 shows some 

commands only when you may need them, in response to an action you take. 

So don’t worry if you don’t see all the commands you need at all times. 

 

Copy, Cut and Paste commands 

You can Copy, Cut and Paste anything into your worksheet. You can copy 

from one worksheet to another worksheet in another book. Let’s concentrate 

on the basics. In next exercise are going to copy cells D4 into H9. 

 

Exercise1: Cut/Copy and Paste to the same worksheet  

1. Using the same worksheet, select cells A4 to D10. 

2. Use CTRL-c to copy and CTRL-x to cut the selected cells. 

3. Click on cell D10. It should be blank 

4. Use CTRL-v to paste the data. You can also use the toolbar shortcuts for 

cut/copy/paste as the functionality is the same. 
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Exercise 2: 

Re-create the example worksheet shown below with your own data 

2. In cell A1, type Full Name and hit Tab 

3. In cell B1, type Address and hit Tab 

4. In cell C1, type City and hit Tab 

5. In cell D1, type State and hit Tab 

6. In cell E1, type Zip Code and hit Tab 

7. In cell F1, type Phone and hit Return. 

8. Continue and add a few examples (do not worry about the content). 

 

 

 

Insert & delete columns, rows, and cells 

Have you ever entered all of your data and realized that you are missing an 

entry in the middle of the worksheet? If yes and you did not know how to add 

columns or rows, it would be really difficult to fix. Well, there is an easier 

method. 

You can insert columns, rows, or cells in any spot on your worksheet. 

 

Insert columns: 

Now you want to add a column to your worksheet to identify specific 

categories. It should go between two existing columns of data.  

Before you can insert a column or row, you need to know how Excel inserts a 

column or a row. 
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• For columns, Excel inserts new column(s) to the left of the selected col-

umn(s). 

• For rows, Excel inserts new row(s) above the selected row. 

1. We want to insert a new column for Last Name between Full Name and 

Address. 

 

 

2. Since Excel inserts to the left, you need to click on the column letter B. 

Column B should be highlighted. 

3. Point (do not left click) the arrow at the B column and then right click. 

4. A pop-up menu should appear. In the menu you should see Insert. 

 

 

5. Click on the word Insert. Excel will insert a blank column between Full    

Name and Address. 

6. Click on B1 and type in Last Name. 

 

Insert rows: 

1. We want to insert a new row for Anne Frank’s contact information be-

tween John Doe and Fred Johnson. 



  
Assis. Lect. Abeer Abd Alhameed Alsallami) 12 

 

 

 

2. Since Excel inserts rows above the selection, you need to click on row 

number 3. Row 3 should be highlighted. 

3.  Right click while pointing at the number 3 

4.  A pop-up menu should appear. In the menu you should see Insert. 

5. Click on the word Insert. Excel will insert a blank row between John Doe and 

Fred Johnson. 

6. Click on A3 and type in Anne Frank’s contact information 

 

In this example we inserted Anne Frank manually to keep records in order by 

Last Name, but let us do this more efficiently. 

 

Deleting and Clearing a Row or Column 

• Clearing data from a worksheet removes the data but leaves the blank 

cells 

• Deleting data from the worksheet removes both the data and the cells 

 

Using the Sort feature: 

You can rearrange, or sort, the records in a table or range based on the data 

in one or more fields. The fields you use to order the data are called sort fields 

and you can sort data in ascending or descending order. 

To sort in alphabetical order: 

 Select a cell in the column you want to sort (In this example, we 

choose a cell in column A). 
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 Click the Sort & Filter command in the Editing group on the 

Home tab. 

 Select Sort A to Z. Now the information in the Category column 

is organized in alphabetical order. 

 

You can Sort in reverse alphabetical order by choosing Sort Z to 

A in the list. 

To sort from smallest to largest: 

 Select a cell in the column you want to sort (a column with num-

bers). 

 Click the Sort & Filter command in the Editing group on the Home 

tab. 

 Select From Smallest to Largest. Now the information is orga-

nized from the smallest to largest amount. 

You can sort in reverse numerical order by choosing From Largest 

to Smallest in the list. 

Example: 
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1.  Select cells A1 to G5 

2.  Go to the Data tab, then click on Sort 

 

3.  In the sort option window, use the pull down boxes to select the sort crite-

ria. In this case we want to sort by Last Name, ascending order A-Z, then 

click on OK. 

4. Your data should look like this. 

 

 

Format and edit data: 

You format and edit data by using commands in groups on the Home tab. For 

example, the column titles will stand out better if they are in bold type.  

To make it so, select the row with the titles and then on the Home tab, in the 

Font group, click Bold.  
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Formatting Cell's Number: 

Excel 2007 provides a variety of number formats that you can apply to the 

values (numbers) you enter in a worksheet to make the data easier to 

interpret. These number formats include currency, accounting, percentage, 

date, time, fraction, and scientific, as well as a few special formats. 

The following variables provide a summary of the number formats that are 

available on the Home tab in the Number group. To see all available number 

formats.  

 Currency: If you enter a financial value complete with the dollar sign and 

two decimal places.  

 

 Percentages: If you enter a value representing a percentage as a whole 

number followed by the percent sign without any decimal places.  

 

 Dates: If you enter a date (dates are values, too) that follows one of the 

built-in Excel number formats, such as 11/10/09 or 10-Nov-09, the pro-

gram assigns a Date number format that follows the pattern of the date. 
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Delete columns and rows 

We all make mistakes. It is very easy to remove a column or rows. 

1. Select the column or row that you want to delete. 

2. Point at the highlighted column name or row name and right click. 

3. A pop-up menu should appear 

4. Select Delete 

5. The column or row should be gone. 

Insert and delete cells 

The insertion or deletion of columns and rows are easy to keep track of. How-

ever, when you insert or delete a cell or a group of cells, you need to be mind-

ful of where these cells are. The reason is that the inserted or deleted cells 

will shift information in the direction of the insertion or Deletion. 

 

1. Select cells B3 to C4. (Click on B3 and hold the left mouse button. Drag the 

cursor to point at C4.) 

2. Right click while pointing anywhere in the highlighted area. 

3. A pop-up menu should appear and select insert or delete. In the example, I 

selected the Insert function 

4. The next window will ask you in which direction would you like to shift the 

cells. If you selected delete, you will see the same options. 

 

Shift cells right will shift the cells in columns to the right by the number of Col-

umns in the highlighted selection.  

For example, if you select B3 to C4, we have 2 columns so the Shift cells right 

will move the selection 2 columns to the right or if it is a deletion, 2 columns to 

the left. 

• Shift cells down will shift the cells in rows downward by the number of rows 

in the highlighted selection. For example, if you select B3 to C4 we have 2 

rows so the Shift cells down will move the selection 2 rows downward or if it is 

a deletion, 2 rows upward. 
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• Entire row and entire column is like using the insert a row or column dis-

cussed earlier. 

 

 

Entering a Formula 

Excel refers to formulas as functions. There are two ways to enter formulas 

in Excel, either use one of the functions already programmed in Excel, or en-

ter your own from scratch. 

• A formula is an expression that returns a value 

• A formula is written using operators that combine different values, 

returning a single value that is then displayed in the cell 

– The most commonly used operators are arithmetic operators 

 

 

Using Excel's functions: 

The easiest way to understand the implementation of Excel functions is by fol-

lowing a step by step example. 
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There are three ways to access Excel's functions, click the function button 

 next to the function window (a popup window appears), find the function 

on the Formulas Ribbon, or type = followed by the function name and a 

bracket {e.g. =sum( }. 

Exercise: It’s easy;Use the Sum button . 

Place the cursor in the last cell in the Quantity column, and then click the Sum 

button on the Home tab. (It’s in the Editing group.)   

Press ENTER to see the formula result.  

 

 

Introducing Functions: 

• A function is a named operation that returns a value 

• For example, to add the values in the range A1:A6, you could enter the 

following long formula: 

 =A1+A2+A3+A4+A5+A6 

  Or, you could use the SUM function to accomplish the same thing: 

 =SUM(A1:A6) 

The result will appear in A7, as shown in figure below. 
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Entering Functions with AutoSum: 

• The AutoSum button quickly inserts Excel functions that summarize all 

the values in a column or row using a single statistic 

– Sum of the values in the column or row 

– Average value in the column or row 

– Minimum value in the column or row 

– Maximum value in the column or row 
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Inserting & deleting new worksheets 

There will be many times when you need to add a whole worksheet rather 

than columns or rows. 

Exercise: Insert a worksheet 

1. Right Click on the tabs where the name of the worksheets is. 

2. Click on Insert 

 

 

3. Select what kind of insert you want from the window. 

 

 

 

4. To move the worksheet, click and hold the left mouse button on the work-

sheet tab drag the tab to where you want it to be placed. Note: you can on-

ly move the worksheet tabs to the left or right. 

 



  
Assis. Lect. Abeer Abd Alhameed Alsallami) 21 

 

Delete a worksheet: 

1. Click on the tab of the worksheet that you want to delete. 

2. Right Click on the same tab of the worksheet 

3. Click on Delete 

 

4. A warning window will appear to ask you if you are sure about the deletion. 

5. If you select OK, the worksheet will be removed and if you select Cancel, 

the worksheet will not be removed. 

 

Copying worksheets: 

You may want to copy the whole worksheet rather than selecting the cells in 

the old worksheet to copy to a new one. Besides being easier to do, there 

might be some links in the cells that do not transfer well. 

 

Exercise: Move or copy a worksheet 

1. Click on the tab of the worksheet that you want to Move or Copy. 

2. Right Click on the same tab of the worksheet 

3. Click on Move or Copy 

4. Select where you want the worksheet to go 
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5. If you want to COPY, you must click in the Create a copy box; otherwise, 

Excel will move the worksheet. 

6. Click on OK 

 

Printing 

Printing your worksheets out to a printer would be a nice thing to know how to 

do. If the information that you have on the worksheet fits on an 8.5”x11” pa-

per, you have no trouble printing your worksheet out. The problem arises 

when you have a larger worksheet. You may have noticed that your work-

sheet has dashed lines running down and across it; this is your print area. 

 

Exercise: Setting the print area 

1. On your worksheet, click on the Page Layout tab. 

2. Click and drag to select the range of cells that you would like to print. 

3. Under Page Layout, click on Print Area, then Set Print Area. 

 

Exercise: How to print with Print Preview 

1. You may click on the paper with the magnifying glass icon or click on the 

Office Button and click on Print, then Print Preview. 
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2. The menu at the top is important because there are many print functions 

that you can use for your worksheet. Here are some examples, turn on the 

gridlines; shrink to fit one page, print headers or footers. 

3. Click on Print. You will be at the Print menu. 

4. Click Page Setup. You will see a control panel that will allow you to make    

some cosmetic changes to the way the worksheet prints. 
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